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1.1  Minimum System Requirement 

To install the MSO Gold, the minimum requirements are: 
¨  OS: Windows XP/2000 

¨  System Requirement: Pentium III 1GHz or better, 128 MB RAM or 
better 

¨  Window Media Player 9 or later 

1.2 MSO Gold Installation* 1 

1. Load the MSO Gold Setup from CD-ROM into your computer. 
2. If you have installed earlier version of MSO Gold, please uninstall before 
you continue the following steps*2. 
3. Double click the “setup.exe ” icon and the setup utility will start with the 
welcome screen, click “Next ” button to continue. 

 
 
4. The setup utility will choose a default folder to install the MSO files. Click 
“Browse ” to browse to the folder you would like to install MSO Gold. Click 
“Next ” to continue installation process. 

                                                           
1 The default software language is English and no other language available in 
the moment. 
2 Please remove MSO Gold from Control Panel if you cannot uninstall MSO 
Gold successfully from Start menu. 
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5. The MSO Gold utility is now installed. Click the “Close”  button to 
complete the installation. 

 
The factory setting for every Network Player Gold is listed below.  
Factory LAN Setting 

IP mode DHCP 

IP port 8001,8002,8003*3 

Server IP (the IP that NP Gold 
connects to automatically) 

192.168.0.188 

 
The default IP mode is DHCP and it will automatically switch to Fixed mode if 
no IP is assigned to Network Player unit. 

IP mode Fixed 

LAN IP 192.168.0.128 

                                                           
3 If your PC is behind a firewall, please make sure port 8001, 8002, 8003 are 
open or set firewall exceptions. 
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LAN Subnet Mask 255.255.255.0 

LAN Gateway 192.168.0.1 

 
Factory Wireless LAN Setting 

WLAN IP 192.168.252.249 

WLAN Subnet Mask 255.255.0.0 

 
Network Player Gold connects to the server actively; therefore, you will need 
to either change the IP that NP Gold connects to or configure the IP address 
of your PC to establish communication channel. We provide a utility to 
configure client settings in you PC and use USB flash drive to apply those 
configurations in Network Player unit. Please refer to1.13 Configuration for 
more detail. 
If you choose to change the IP address of your PC, please make sure your 
desktop or laptop’s IP address comply the following rules. 
Path to call Internet Protocol(TCP/IP) Property:  

�  Click Start� Control Panel�  Double-click on Network 
Connections.  

�  Right-click on Local Area Connection �  select Properties.  
�  On General tab , double click Internet Protocol (TCP/IP) 
�  Setup client IP 
�  Click OK to confirm the setting 

 
After the configuration of server IP, you can use a crossover cable or a hub 
to connect client and server. 
 
 

The IP address of your server PC 

has to be 192.168.0.188 in order to 

establish connection in the first 

time. Then you are free to set the 

server IP address. 
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1.3 Starting the MSO Gold 

1. Click MSO Gold icon on your desktop. 

 
2. If this is the first time you start the MSO Gold, a pop-up window will guide 
you to set up your own password.*4 
3. Enter your password in the Password column.  
4. Click the “OK” button to start MSO Gold. 

. 
 
 
 

1.4 Media Creation, Scheduling, Distribution Workfl ow 

Before you start operating MSO Gold, you should know general naming 
convention that we use in this document. 

General rule of naming convention:  
1. No space between any object name, such as group, client, template, 

schedule…etc. 
2. No special character allowed, such as ~!@#$%^&*()...etc. 
3. Working area of MSO Gold. 

                                                           
4 The password should not contain special characters. We strongly suggest 
you select a password consisting of uppercase and lowercase letters, 
numbers, and special characters. 

�  Tips: you can press F1 to show 
user manual in PDF format. 
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Workflow of MSO Gold Content Distribution 
There are 5 major sections in MSO Gold: 
�  Client Management 
�  Media Management 
�  Playback Management 
�  Advanced Control 
�  Report Management 
MSO Gold remains great flexibility to allow users work on each task 
independently and also be able to share resources between different groups. 
Basically, schedule is a component that combines all tasks and transfers 
them to selected network players. The workflow of MSO Gold is listed below. 

MSO Gold Content 
Distribution Workflow

Group Media Layout Playlist

Schedule

��������	
���� ��������	
���� ��������	
����

��������

 

Left 
Pane 

Upper 
Pane 

Lower 
Pane 
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Example 1: hierarchical structure in a shopping cen ter 

Layout of building: 
�  1st Floor:  Entry, Food & Toys 
�  2nd Floor: Women’s Fashion, Men's Fashion 

Customer would like: 
�  Place a 32” Network Player in the Entry to welcome 

customers and inform them about news and events 
�  Play daily and seasonal promotions in the food court 
�  Play cartoon, new games and toys Ad in Toys department 
�  Play individual fashion shows in Men’s and Women’s 

department, with information about brand and style 

Layout of Shopping Center

1st Floor 2nd Floor

stairs stairs

Food

Men’s Fashion

Women’s Fashion

3

2

9

4

5

6

8

entry
1

7

Toys

 
In order to apply the hierarchical structure of a shopping center, you will need 
to create Groups under the Event: Entry, Food, Toys, Women and assign 
players to each group. You will also need to create different layout template 
for according to what you will display in Network Player. Depends on display 
zones of the layout, you can add different media files into the playlist. In the 
last step, you can define create a schedule and include each components 
and then transfer this schedule to your players. 

1.5 Client Management 

In MSO Gold, every client must belong to a group; therefore, you need to 
create a group for client assignment. 
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1.5.1  Group Creation 

1. Click the “Add & Remove Group ” button to bring up group adding 
window. 

2. Click the “Add ” button and enter group name. 
3. Click the “OK” button to save the new group. 
4. Choose the Group Level  from the drop-down menu. Click the “Exit ” 

button when you finish. 

 

1.5.2  Group Deletion 

1. Click the “Add & Remove Group ” button to bring up group adding 
window. 

2. Highlight the group you would like to delete and click the “Remove ” 
button to confirm the deletion. 
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1.5.3  Client Creation 

1. Click the “Add Client ” from drop-down menu. 
2. If there are clients already connect to server, you can highlight one 

Online Clients and choose a group in Destination Group , then click the 
“Add Clients ” button to bring up “Add a New Client ” window. 

3. Enter client name then click the “OK” button to complete client addition. 
4. If there are no clients connect to server at the moment, you can highlight 

the group you would like to add new client then choose the “Add Offline 
Client ”. 

 
5. Enter client name and MAC address and then click the “OK” button to 

save settings. 

1.5.4  Client Deletion 

1. Highlight the client you would like to delete, and then click the “Remove 
Client ” button to confirm deletion. 
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1.5.5  Client Configuration 

In Client Management section, you are able to view and change client 
settings, including Group, LAN, WLAN, Auto Reboot, Time Zone, and others. 
Group  

 
 You can choose a group from the drop-down menu and assign a client 

to the group, and then click the “Set” button to save settings. 
 You can change the server IP (the IP that client will connect to 

automatically) and click the “Set” button to save settings. 
 You can click the “Client Reboot ” button to reboot the client 

immediately. 
 You can click the “Delete All Content ” button to send command to a 

client and delete all content in its internal storage. 
 You can click the “Transferring Log ” button to get client playing log 

report. 
LAN 

 
 You can change client IP Mode according to your network 

environment*5, click the “Set” button to save settings. 

                                                           
5 The default IP mode is DHCP and it will automatically switch to Fixed mode 
if no IP is assigned to Network Player unit. 
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WLAN* 6 

 
1. Enable the “WLAN On ” checkbox and fill in IP, Subnet Mask, Gateway, 

ESSID and Channel. 
2. Enable the “WEP”*7 checkbox and fill in keys if your wireless AP has 

WEP key protect. 
3. Click the “Set” button to save settings. 
Auto Reboot  

 
1. The network player will do system check when booting up, so you can 

setup auto reboot time for client to clean up unnecessary system file 
everyday.  

2. Enable the “Auto Reboot Enable ” checkbox and choose the reboot 
time. 

3. Click the “Set” button to save settings. 
Time Zone  

                                                           
6 LAN and WLAN ports are able to work simultaneously, however, they 
should be in different subnet. If LAN and WLAN are in the same subnet, the 
LAN's priority is higher than WLAN. In this case, WLAN is inactive. Contact 
your system administrator for setting information. 
7 The Network Player does not support Ad-hoc mode WLAN. You should 
always use a WLAN AP to connect the Network Player unit. The WEP key 
must be 10 or 26 hexadecimal digits. 
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1. Choose the time zone according to client’s location and click the “Set” 

button to save settings. 
Miscellaneous  

 
1. Choose Boot Mode from the drop-down menu. The default boot mode is 

INSTALLATION  mode, which will display all client information such as 
IP, MAC address, subnet mask, server IP, storage, and firmware version 
in boot-up screen. The NORMAL mode will only show boot-up picture 
without displaying any sensitive client information. 

2. Enable the “Enable Hot Key of Trigger Event ” checkbox to activate 
Trigger Event function. 

3. Click the “Disk Repair ”*8 button to repair internal storage. 
4. If you ever use remote control to adjust volume of integrated Network 

Player LCD, volume adjustment via network will be disabled after since. 
You can click the “Volume Restore ” button to restore default volume 
setting (50 out of 100 maximum) and gain the volume control back. 

5. You can give each client a number as client ID for identification. The 
value is limited and has to be 0~254. Baud rate indicates the number of 
bits per second is transmitted. Normally five values can be chosen: 9600, 
19200, 38400, 57600, and 115200. The default baud rate of Network 
Player is 38400. Click the “Set” button to save RS232 settings. 

1.6 Media Management 

Media Management  is a place where you can manage all media files, 
including video, picture, and message. 
Video  

                                                           
8 The “Disk Repair ” function allows the system to check disk and auto repair 
broken segments. 

MSO Gold    User Manual V1.3  

  Page 16 

 
Video Addition* 9 
1. Click the “Add Files ” button and browse to the video files you would like 

to add. 
2. Click OK to confirm file addition. 
Video Deletion 
1. Highlight the video you would like to delete, and then click the “Remove ” 

button to confirm deletion. 
Video Information 
1. You can preview video or see video information in the bottom of window. 

 
Picture  
Picture Addition 
1. Click the “Add Files ” button and browse to the picture files you would 

like to add. 
2. Click OK to confirm file addition. 
Picture Deletion 

                                                           
9 The Landscape Video and Portrait Video areas are only for you to 
distinguish different mode of videos. Please refer to Appendix B for Portrait 
Video creation. 
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1. Highlight the picture you would like to delete, and then click the 
“Remove ” button to confirm deletion. 

Picture Information 
1. You can preview picture or see picture information in the bottom of 

window. 

 
Message  
Message Addition 
1. You can use any text editor to create your own text message and save it 

as .txt file. Click the “Add Files ” button and browse to the text file you 
would like to add. 

2. You can also click the “Add String ” button to type text message. 

 
3. Choose message height from the drop-down menu, then and click the 

“Font ” and the “Background Color ” button to change related settings. 
4. You can enable the “Apply all files ” checkbox if there are more than 

one text files are selected and you would like to apply the same font and 
background color to them. 

5. Click the “OK” button to confirm file addition. 
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Message Edit* 10 
1. Highlight the string you would like to edit, and then click the “Edit 

String ” button to follow the editing procedure. 
Message Deletion 
1. Highlight the message you would like to delete, and then click the 

“Remove ” button to confirm deletion. 
Message Information 
1. You can preview message or see picture information in the bottom of 

window. 

 
Instant Message  
In Instant Message Mode, the message can be updated independently 
without system reboot. However, the message will run from right side to left 
side only once, and then it turns back to the original message. The addition, 
edit, deletion, and preview of instant message are totally the same as 
message. Please refer to the Message section above for more detail. 

                                                           
10 Text message from txt file is not editable. 
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1.7 Playback Management 

1.7.1  Layout Template 

In MSO Gold, users are able to create their own layout design for 
background, video, picture, message, and clock. The maximum numbers of 
display zone are 1 background picture, 1 Video/Picture/Input zone, 2 picture 
zones, 2 message zones, and 1 clock zone. 

 
Layout Template Creation 
1. Click the “New Template ” button and enter template name to create a 

new layout template. 
2. Highlight the template you would like to define its display zones. 
3. Click the “Load Sample Layout ” button and select the layout you like or 

do step 4~5 to create your own layout template. 
4. Select Screen Mode  (Landscape / Portrait). 
5. Enable the checkbox of a display zone that you would like to create. 

Click the button of this display zone and use mouse to drag the zone 
size in the preview window. 

6. Repeat step 1~5 to create more display zones if you like. 
7. Use the “…” button to browse the background picture if you would like to 

setup background for the layout template. Or you can type the path in 
the column and click the “Set” button to load the background picture. 

8. Click the “Save” button to save all settings. 
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Layout Template Edit 
1. Highlight the layout template you would like to edit. 
2. Drag each display zone and change the zone size or display layout. You 

can also click on a display zone and use absolute percentage to change 
the X, Y position, Width and Height of that zone. 

3. Click the “Save” button to save all settings. 

 
Layout Template Deletion 
1. Highlight the layout template you would like to delete, and then click the 

“Remove Template ” button to confirm deletion. 
 

1.7.2  Playlist 

Playlist  is a place where you can define media files playback, including 
video, picture, message, and clock. 
Playlist Creation 
1. Click the “Add ” button to add a new playlist. 
2. Enter playlist name then choose layout template and group level from 

the list. 
3. Click the “OK” button to finish playlist creation. 
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4. Highlight the layout template you would like to add media files. Depends 

on the layout you choose, you will see tabs for different display zone. 

 
5. In each tab of display zone, use the “Add ” and “Remove ” button to add 

or delete media files. 
Video/Pic/Input Zone* 11 
a. Select media files from Media DB and click the “Add ” button to add it 

into playlist. 

                                                           
11 The high-definition video can only be congested by Group Level 550 and 
650 series of Network Player. The Input signal is only available for Group 
Level 650 of Network Player; please make sure your network player support 
this feature. 
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b. You can use the “UP” and the “DN” button to rearrange the playback 

order. 
c. Click the “Exit ” button to save settings. 
d. The default display setting of video is full screen, volume level 50, and 

plays once then goes to the next media file. You can uncheck the full 
screen checkbox to remain original ratio, change volume and repeat 
time, and then click the “Set” button to save all settings. 

 
e. The default playback duration of input signal is 60 seconds then change 

to the next media file. You can change the playback duration and click 
the “Set” button to save settings. 

 
Picture Zone 

a. Select picture files from Media DB and click the “Add ” button to 
add it into playlist. 
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b. You can use the “UP” and the “DN” button to rearrange the 

playback order. 
c. Click the “Exit ” button to save settings. 
d. The default playback duration of picture is 10 seconds and then 

goes to the next media file. You can change the picture showing 
time and transition effect, and then click the “Set” button to save 
all settings. 

 
Message Zone 

a. Select picture files from Media DB and click the “Add ” button to 
add it into playlist. 
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b. You can use the “UP” and the “DN” button to rearrange the 

playback order. 
c. Click the “Exit ” button to save settings. 
d. The default playback repeat time of message is one time, speed is 

8 pixel*12, and scrolling direction from right to left. You can change 
the repeat time, speed, direction, and then click the “Set” button to 
save all settings. 

 
Playlist Edit 
1. Highlight the playlist you would like to edit. 
2. Click the “Edit ” button to make related changes to the playlist. 

                                                           
12 From 1-15, 1 indicates the slowest speed and 15 indicates the fastest 
speed. 
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Playlist Deletion 
1. Highlight the playlist you would like to delete, and then click the 

“Remove ” button to confirm deletion. 

1.7.3  Schedule 

Schedule  is a place where you can define playback schedule for groups and 
also setup playlist for this schedule. 
Schedule Creation/Deletion 
1. Click the “Add/Remove Schedule ” button to initiate schedule addition 

or deletion. 
2. Choose a group which you would like to create schedule from the group 

list. Click the “Add ” button to create a new group if at the moment the 
group does not exist. 
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3. Click the “Add ” button from the Schedule area, and then enter schedule 

name. Click the “OK” button to complete schedule addition. 
4. Repeat step 3 if you would like to add more schedule. Click the “Exit ” 

button when you are finished. 
5. In schedule management window, you will see the schedule is created 

with default timeslot. 
6. Highlight a schedule from the left pane and choose output type , 

resolution , and orientation  from the lower pane.  
7. You can check the “Enable media sync for this schedule ” checkbox to 

enable auto media synchronization. If this is enabled, you should also 
specify media upload time and playlist apply time*13. You can also check 
the “Enable Time Sync Everyday ” checkbox to enable auto time sync. 

 

                                                           
13 Media Upload Time indicates the time that the network player will download 
media files and playlist. Playlist Apply Time indicates the time that the 
network player starts playing. 
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8. Highlight the timeslot and choose a Playlist Template from the drop-
down menu. You can select or unselect bars under weekly days to make 
schedule on or off. Green bar means schedule on and red bar means 
schedule off . 

 
Timeslot Creation 
Except the default timeslot in a schedule, you can also create other timeslots 
for special events such as playing only during weekdays from 8AM to 5PM, 
special sales event for Oct 3 to Oct 5 from 11AM to 9PM. The priority of 
user-defined timeslot is higher than default timeslot. The schedule of default 
timeslot will be running if there are no other user-defined timeslots. 
1. Click the “Add Time Slot ” button to initiate timeslot creation. 
2. Select the group and schedule you would like to add timeslot, and then 

enter timeslot name. 
3. Click the “OK” button to complete timeslot creation. 
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4. Highlight the timeslot you just created and choose a Playlist Template 
from the drop-down menu, and then setup the playback date and time*14. 
You can select or unselect bars under weekly days to make schedule on 
or off. Green bar means schedule on and red bar means sched ule 
off.  

 
 
 
 
 
 
Timeslot Deletion 
1. Highlight the timeslot you would like to delete, and then click the 

“Remove Timeslot ” button to confirm deletion. 

1.7.4  Instant Message 

You can edit instant message template in case if any emergency or 
broadcast that needs to be sent immediately. Note that instant message can 
be updated independently without system reboot. However, the message will 
run from right side to left side only once, and then it turns back to the original 
message. 
Instant Message Template Addition 
1. Click the “Add ” button and enter instant message template name, and 

then click the “OK” button to complete instant message template 
creation. 

2. Highlight the instant message template you just created from the instant 
message template list. 

3. Click the “Add ” button in the bottom of Instant Message window to add 
text files. 

                                                           
14 The time of timeslots can not be overlapped if there are more than one 
timeslots in a date. 

�  Tips: Depends on the orientation 
(landscape/portrait) of a schedule, only suitable 
Playlist will appear in the drop-down menu. 
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4. Select text files from Media DB and click the “Add” button to add it into 

playlist. You can use the “UP” and the “DN” button to rearrange the 
playback order. 

5. Click the “Exit ” button to save settings. 

 
Instant Message Template Deletion 
1. Highlight the template you would like to delete, and then click the 

“Remove ” button to confirm deletion. 
2. You can highlight instant messages from the Instant Message List and 

click the “Remove ” button to remove them from the Instant Message List. 
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Instant Message Transfer 
When you are done with the Instant Message Template creation, you can 
select one template and transfer it to one or more groups. 
1. Highlight the template you would like to transfer and then click the 

“Transfer ” button to initiate transfer process. 
2. Highlight a group you would like to transfer and click the “Add ” button to 

add it to destination. 
3. Repeat step 2 if you would like to add more groups. You can highlight a 

group from destination area and click the “Remove ” button to remove it 
from destination list. 

4. Click the “Transfer ” button to start instant message transfer. 

 

1.7.5  HTML Bulletin 

HTML, an initialism of Hypertext Markup Language, is the predominant 
markup language for web pages. It provides a means to describe the 
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structure of text-based information in a document. The HTML file can embed 
links to database and show real-time information such as bus schedule, 
currency exchange rate, airline schedule, class schedule, and so on. 
Applications including bus stations, banks, airports, schools, clinics, and 
much more. 
HTML Bulletin Creation 
1. Select a group under Bulletin icon in the left pane. 

 
2. Click the “Add ” button to add HTML source. 
3. Enter HTML name and type. You can choose to read from local text file 

or HTML URL as Bulletin source. Click the “Enable ” checkbox if you 
would like to activate this source in Bulletin list. 

 
4. Click the “OK” button to complete Bulletin source creation. 
5. Repeat step 2~4 if you would like to add more Bulletin source. 
6. Highlight a Bulletin source and click the “Preview Item ” button to 

preview individual Bulletin source. 
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7. In the lower pane, you can setup Bulletin refresh period, playlist loop, 

showing duration, transition effect, capture picture width and height. 

 
8. When you are done with all settings, click the Bulletin  icon in the left 

pane. You will have a good overview in the upper pane and you can 
change Refresh Period  and Playlist Loop  in the lower pane. You can 
enable the “Enable Bulletin ” checkbox to start real-time Bulletin. Note 
that the Bulletin will be running continuously until you uncheck the 
“Enable Bulletin ” checkbox or when the connection to server is lost. 
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Bulletin Source Deletion 
1. Highlight the bulletin source you would like to delete, and then click the 

“Remove ” button to confirm deletion. 
Bulletin Source Edit 
1. Highlight the bulletin source you would like to edit. 
2. Click the “Edit ” button to make related changes to the bulletin source. 

1.7.6  RSS Feed (Really Simple Syndication) 

RSS is a family of web feed formats used to publish frequently updated 
content such as blog entries, news headlines or podcasts. 
Web browser Internet Explorer (IE) is necessary for the successful use of 
RSS. Internet Explorer 7 (IE7) supports re-directing URL. If you use web 
browser version earlier than IE7, the URL must be a real URL without any re-
direction. 
RSS Message Creation 
1. Select a group under RSS icon in the left pane. 

 
2. Click the “Add ” button to add RSS source. 

Group RSS Overview 

Overall Attribute Setting 
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3. Enter RSS name and type. You can choose to read from local text file or 
RSS URL as RSS source. All RSS sources are enabled by default. 

 
4. Click the “OK” button to complete RSS source creation. 
5. Repeat step 2~4 if you would like to add more RSS source. 
6. Highlight a RSS source and click the “Preview RSS List ” button to 

preview individual RSS source. 

 
7. You can click the “Preview Refresh ” button to preview the whole RSS 

message from the Text Preview window before you send it. Note that 
disabled RSS source will not appear in the preview window. 

8. When you are done with all RSS source creation, click the RSS Feed 
icon in the left pane. In the lower pane, you can setup RSS font, 
background color, refresh period, and scrolling speed for all RSS source. 
Enable the “RSS running ” checkbox in the lower pane to start RSS 
message. Note that the RSS message will be running continuously until 
you uncheck the “RSS running ” checkbox or when the connection to 
server is lost. 
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RSS Message Deletion 
2. Highlight the RSS message you would like to delete, and then click the 

“Remove ” button to confirm deletion. 
RSS Message Edit 
3. Highlight the RSS message you would like to edit. 
4. Click the “Edit ” button to make related changes to the RSS message. 

1.8 Advanced Control 

1.8.1  Trigger Event 

In MSO Gold, users can define their own command to trigger a playlist, 
command interface including RS232, keypad, IR, LAN, motion detect, and 
GPS. You can click the “Help” button in each type of trigger event to view 
detailed description. Note that Advanced Control is not standard feature 
in MSO Gold; each feature is only available upon pr oject request.  
Trigger Event Addition 
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1. Click the “Add ” button to create different interface of trigger. 
 
 
RS232 
Description: 
Edit a RS232 command which can trigger a play list. 
Command Index: 
Command Index is used to combine lead string and command string. 
The lead string is a fixed string “RS232_”; the command string is defined by 
user. 
For example, the command string is “INDEX1”. 
User could send a command which re-pack for “INDEX1” to trigger the play 
list. 

 
How to trigger? 
Send the string command to network player via RS232. The command 
format is described below: 
CP(command package)=header +package type +slaveID +command 
length +command +checksum +tailer . 
Bytes              = 1 + 1 + 2 + 4 + n + 2 + 1 
  

Name Length Description 

header 1 A constant text “T” 

Package Type 1 “C”:for command package 
“A” for Ack package 

Slave ID 2 Hex in “00”~”FF” 
“00” is reserved 
“FF” is for broadcast mode 
Otherwise is a specified ID 

Define which zone you would 
like to replace with new 
playlist if this trigger is 
received by network player. 
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Command length 4 Command length in Hex 
“0000”~”FFFF” 

Command N A user defined command 
string 

Checksum 2 Checksum of command in hex 
“00”~”FF” 

Tailer 1 A Constant text ”\n” 

For Example a command string :TC010006INDEX1A9’\n’ 
 
Keypad  
Description: 
Indicate keypad to trigger a pre-defined playlist.. 
Command Index: 
Command Index is used to combine lead string and command string. 
The lead string is a fixed string “BTN_”, command string could be selected 
only “1”,”2” 
Button 1 indicates the Volume Up  button in the OSD keypad, Button 2 
indicates the Volume Down  button in the OSD keypad. 
For example, the command string is “1” 

 
Note: Button 3 is used for “Next Playlist Trigger”, which indicates the 
Brightness Increase  button in the OSD keypad. 
Note: Button 4 is used for “Previous Playlist Trigger”, which indicates the 
Brightness Decrease  button in the OSD keypad. 
 
Client Configuration: 
After this keypad trigger event is done, user has to enable the hotkey 
function in ClientManagement/Device/Group/Client  and enable the hotkey 

Define which zone you would 
like to replace with new 
playlist if this trigger is 
received by network player. 
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of trigger event. Note that when hotkey trigger event is enabled, the  
original OSD keypad function will be disabled. 

 
How to trigger? 
Trigger play list: 
Click the button1 or button 2 to trigger the playlist 
Trigger play list: 
Click the specified next/previous key on the keypad to trigger next/previous 
play list. 
 
IR 
Description: 
Edit an IR code which can trigger a play list. 
IR Custom code setting: 

 
User can set the custom code and define the next and previous trigger code. 
Once the user press the next/previous trigger key on the IR remote, network 
player will play the next/previous trigger play list. 
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Command Index: 
Command Index is used to combine lead string and command string. 
The lead string is a fixed string “IR_”, command string is a two digit hex string. 
For example, the command string is “1A” 

 
How to trigger? 
Trigger play list: 
Click the specified key on the IR remote will trigger the play list 
Trigger play list: 
Click the specified next/previous key on the IR remote to trigger 
next/previous play list. 
 
LAN 
Description: 
Edit an LAN command which can trigger a play list. 
Command Index: 
Command Index is used to combine lead string and command string. 
The lead string is a fixed string “LAN_”,command string could be a string 
which string length is limited under 32. 
For example, the command string is “INDEX1” 

Define which zone you would 
like to replace with new 
playlist if this trigger is 
received by network player. 
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How to trigger? 
1. Click the “Send LAN Trigger ” button to initiate LAN trigger process. 
2. Select groups you would like to send LAN trigger and click the “Add ” 

button to add those groups into destination list.  
3. Type LAN command in LAN Trigger Command column and click the 

“Transfer ” button to start transferring. 
 
Motion Detect  
Description: 
Edit a playlist for motion sensor’s active stage. 
Command Index: 
No Need. 
How to trigger? 
The play list would be applied when motion sensor detect an object 
movement. 
 

Define which zone you would 
like to replace with new 
playlist if this trigger is 
received by network player. 
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GPS 
In MSO Gold, user will be able to define a play list for an area. The GPS 
module continuously feeding the coordinates to Network Player via RS232 
port, so Network Player can display different play list depends on its 
geographic position. 

 
 

 
Description: 
Edit the coordination of an area to trigger the specified play list 
Command Index: 
Command Index is used to combine lead string and command string. 
The lead string is a fixed string “GPS_”. 

Zone1 

Zone4 

Zone2 Zone3 Spot1 

Spot2 

Spot3 

Layer1 
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Fill in the coordinates*15 of the Top-left and the Bottom-Right of an area and 
then select the display zones you’d like to use in the play list.  

 

 
 

 
How to trigger? 
1. Connect the GPS module to the player’s RS232 port. 
2. The player will parse the GPS module’s output and play the specified 

play list according to the coordinate. 
 
Note that you MUST set player’s RS232 baud rate to be 4800 and reboot 
the player in order receive coordinates from G-mous e successfully. 

 

                                                           
15 You can use any navigation software to acquire coordinates of an area. 

Define which zone you would 
like to replace with new 
playlist if this trigger is 
received by network player. 
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When you are done with the creation of triggers, you can highlight each 
trigger and choose media files for this trigger. 

 
1. Highlight a trigger from the trigger management window. Depends on 

what display zone you have defined for this trigger, you will see different 
tabs in the lower pane. 

2. Click the “Add ” button to add media files from media DB. Click the “Exit ” 
button to save all settings when you are done. 

 
Trigger Event Deletion 
1. Highlight the trigger event you would like to delete, and then click the 

“Remove ” button to confirm deletion. 
2. You can highlight media file from the Media List and click the “Remove ” 

button to remove them. 
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Trigger Event Edit 
1. Highlight the trigger event you would like to edit. 
2. Click the “Edit ” button to make related changes to the trigger event. 
Trigger Event Transfer 
When you are done with the Trigger Event creation, you can select one or 
more trigger event and transfer them to one or more groups. 
1. Highlight the trigger event(s) you would like to transfer and then click the 

“Transfer ” button to initiate transfer process. 
2. Highlight a group you would like to transfer and click the “Add ” button to 

add it to destination. 
3. Repeat step 2 if you would like to add more groups. You can highlight a 

group from destination area and click the “Remove ” button to remove it 
from destination list. 

4. Click the “Transfer ” button to start trigger event transfer. 

 
5. Click the “Export to USB Drive ” button if you would like to transfer 

Trigger Event via USB drive. Browse to the USB drive path and choose 
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correct layout mode. Click the “OK” button to finish USB drive exporting 
process. You should then plug the USB drive to Network Player, reboot 
the device to start exporting. Unplug the USB drive and reboot the 
Network Player when the exporting is complete. 

 
IR Config 
Please refer to 1.8.1 Trigger Event  for detailed description of IR trigger 
event. 
Send LAN Trigger 
After you transfer LAN trigger to network player, you can use Send LAN 
Trigger  function to send commands through RJ45 cable and trigger related 
playlist. 
1. Click the “Send LAN Trigger ” button to initiate LAN trigger process. 
2. Select groups you would like to send LAN trigger and click the “Add ” 

button to add those groups into destination list.  
3. Type LAN command in LAN Trigger Command column and click the 

“Transfer ” button to start sending command. 

1.9 Report Management 

The Report Management is ideal for retrieving playing logs from clients in a 
group. MSO Gold generates three files for your convenience to view the 
client log. Due to the numerous playing activities written to the network 
player, the network player will only remain playing log for 7 days. 
1. In the Report Management, select the group you would like to get 

playing log. 
2. Browse to the file saving path and click the “Get” button to start 

downloading playing log from client. Playing log of the past 7 days will 
be generated. 

 
3. You can check the “Enable ” checkbox to enable auto playing log 

download routine. You should specify routine download day, time, and 
file saving path and click the “Set” button to setup auto download. 
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4. The system will create 3 CSV files for your convenience to view the 
client log. 

 
PlayingLog Contains all detailed playing activities of all 

players in a group. 

ClientBasePlayingLog Contains file name and total playback time based 
on each client. 

FileBasePlayingLog Contains client name and total playback time 
based on each file. 

1.10 Save 

You should save all changes when you are done with all creation, deletion, 
modification, and other activities. Due to the numerous activities you might 
have done, the saving process may take a while (up to 30 seconds). 
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1.11 Transfer 

 
You should transfer schedule to groups in order to apply playlists. 
1. Click the “Transfer ” button to initiate transfer process. 
2. Select a group and then select a schedule. Click the “Add ” button to add 

this schedule into destination list. 
3. Repeat step 2 if you would like to add more schedules. You can 

highlight a schedule from destination area and click the “Remove ” 
button to remove it from destination list. 

4. Check the “Clear the client’s storage before transfer ” checkbox if you 
would like to clear out the client’s internal storage. Click the “Transfer ” 
button to start schedule transfer. 

5. You can click the “Transfer Log ” button to view the transfer history. 
6. If you would like to transfer selected schedules to USB drive, you should 

choose output type and resolution and then click the “Export ” button to 
start schedule transfer. You should then plug the USB drive to Network 
Player, reboot the device to start exporting. Unplug the USB drive and 
reboot the Network Player when the exporting is complete. 
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1.12 Event Viewer 

Event Viewer is a place where you can view all media update time, schedule 
apply time, playing log download time and status of those activities. 
1. Click the Event Viewer to view all pre-defined activites. 
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1.13 Configuration 

The Configuration contains functions such as Update Firmware, Update 
Logo, and USB Configuration Export. 

 
 
 

Update Firmware 
Ever since a while, we add new features in MSO Plus to meet customer’s 
requirement. You can fully utilize those features by updating the latest 
firmware. Note that all media contents will be deleted if upd ate firmware 
via USB. Choose LAN as the update option if you wou ld like to keep 
media contents.  
 
Check Firmware Version 

Depends on the display size and the existent version of firmware in your 
Network Player Unit, you can choose the most convenient way to upgrade 
firmware. You will be able to check the firmware version of Network Player in 
the beginning of system boot up. 
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1. Click the “Update Firmware ” button from the Configuration window. 
2. Highlight a group you would like to transfer and click the “Add ” button to 

add it to destination. 
3. Repeat step 2 if you would like to add more groups. You can highlight a 

group from destination area and click the “Remove ” button to remove it 
from destination list. 

4. Browse to the firmware file and click the “Update ” button to start 
firmware update process. 

 
Update Logo 
User can define his own boot-up logo easily in MSO Gold. Acceptable picture 
type: jpeg. Resolution is limited no bigger than 720 x 480. 

Firmware 
Version 

 
 Active Mode Network Player 
Server IP: 192.168.0.188 

LAN 
IP: 192.168.0.128 
MAC: 00:00:00:01:01:01 
IP Mode: Fixed 
Mask: 255.255.255.0 

WLAN 
 IP: N/A 
MAC: N/A 
IP Mode: N/A  
Mask: N/A 
WEP: Off 

Default gateway 
  192.168.0.1 
HW 
  Storage: 488 MB 
FW version: 111IW 
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 Active Mode Network Player 
Server IP: 192.168.0.188 

LAN 
IP: 192.168.0.128 
MAC: 00:00:00:01:01:01 
IP Mode: Fixed 
Mask: 255.255.255.0 

WLAN 
 IP: N/A 
MAC: N/A 
IP Mode: N/A  
Mask: N/A 
WEP: Off 

Default gateway 
  192.168.0.1 
HW 
  Storage: 488 MB 
FW version: 111IW 

 

 
1. Click the “Update Logo ” button from the Configuration window. 
2. Highlight a group you would like to update logo and click the “Add ” 

button to add it to destination. 
3. Repeat step 2 if you would like to add more groups. You can highlight a 

group from destination area and click the “Remove” button to remove it 
from destination list. 

4. Browse to the logo file and click the “Update ” button to start logo update 
process. 

USB Configuration Export 
This function is really convenient for you to configure client settings without 
using a crossover cable or a hub. Configurations you can make with this 
function including the Server IP that the client should connect to, client LAN 
settings, client WLAN settings, and client time zone. 
1. Click the “USB Configuration Export ” button from the Configuration 

window. 
2. Make setting changes. 
3. Browse to the location (USB flash drive) you would like to save the files. 
4. Click the “Save” button. 
5. Click the “Exit ” button. 

Boot-up logo 
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6. Take the USB flash drive and plug it into Network Player unit. 
7. Reboot the Network Player unit to apply settings. 

1.14 User Management 

In MSO Gold, the administrator can create user accounts for other users 
working on the same PC. Each user account will have its own database and 
settings. Note that only administrator has the privilege to see User 
Management and create user accounts. 

 
 

1. Click the “Add an User ” button and enter username and password for 
the new user account. 

2. You can highlight a user and click the “Remove the user ” button to 
delete the user account. 
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3. You can highlight a user and click the “Change Password ” button to 
change the password of a user account. 
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Appendix A How to Get Codec 
Information 
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1. We suggest you download and install the “K-Lite code pack 2.50 Full” from�
�����������	
���

���
��
�����������������������
���
����� � to your PC if you 
would like to see the CODEC information of your media file. 

�
2. After successfully install “K-Lite code pack 2.50 Full” application. Please 
open the “GSpot Codec Information” application from Starts->Programs->K-
Lite Codec Pack->Tools->GSpot Codec Information �

� �
�

The GSpot dialog will appear. Open the media file that you want to get 
codec information from�File->Open �

�
The “GSpot” application will display the detail information about the media 
file. You can get the audio and video codec information from “Audio” and 
“Video” sections. 
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Appendix B  Video Editing Tutorial 
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1. Goals and Objectives 
Video cut by some utilities doesn’t have very good compatibility with Network 
Player series. In this document, we will introduce the utility that has been 
tested and works well in Network Player series. The methods of splitter, 
rotate and encode will be introduced step by step in the following sections. 
 

2. Utility 

Before we start, please download the convert utilities “VirtualDub-Mpeg2”, 
“VirtualDub” and necessary codec pack: “K-Lite code pack”. 
 

2.1 What is virtualdub? 
VirtualDub is a video capture/processing utility for 32-bit Windows platforms 
(95/98/ME/NT4/2000/XP), licensed under the GNU General Public License 
(GPL).  It lacks the editing power of a general-purpose editor such as Adobe 
Premiere, but is streamlined for fast linear operations over video.  It has 
batch-processing capabilities for processing large numbers of files and can 
be extended with third-party video filters.  VirtualDub is mainly geared toward 
processing AVI files, although it can read (not write) MPEG-1 and also 
handle sets of BMP images(From http://www.virtualdub.org/index) 
Download utilities 

VirtualDub 
http://virtualdub.sourceforge.net/ 

VirtualDub-Mpeg2 : 
 VirtualDub mod with MPEG2 (SVCD, DVD, VOB) import support. 

http://www.free-codecs.com/download/VirtualDub-MPEG2.htm 
 

2.2 What is K-Lite code pack? 
K-Lite Codec Pack is a collection of codecs and related tools. Codecs are 
required to encode and/or decode (play) audio and video. The K-Lite Codec 
Pack is designed as a user-friendly solution for playing all your movie files. 
With the K-Lite Codec Pack you should be able to play 99% of all the movies 
that you download from the interne 
Download site : http://www.free-
codecs.com/download/K_Lite_Codec_Pack.htm 
 

3. Video Editing 
In this section, the split, rotate, and compression will be introduced. Video 
splitter can help you split large file into smaller video clips, and you also 
could get the part you want. The rotate function could let video rotate 90 
degree to right or left, or rotate around by 180 degree. To let the size of video 
become smaller and keep its quality, the Mpeg4(xvid) will be used. 
 

3.1 Codec Information 
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To understand what the codec the media is, you could use the “Gspot 
codec information ” utility. From “Start->Program->K-Lite codec Pack-
>Tools->Gspot codec information .”  
1. Click “File->Open” to open the video file. 
2. Then you could get the codec information about the video file. 

 

3.2 Split and Cut Video 
1. Execute the VirtualDub or VirtualDub Mpeg2 according to you video 

type. 
2. Then select “File-> Open video file”  to open the video file. 
3. Drag the slider below the panes to change the current position within 
the video. 

4. Drag the slider to start position, then press the  to mark start. 

5. Drag the slider to end position, then press the  to mark end. 
 

 
<Pic 1> 
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3.3 Rotate the Video 
1. Select “Video->Filters ”, and click “Add ” button on the Filters  dialog. 
2. In “Add Filter ” dialog (Pic2), please select “rotate ”. 
3. After click “OK” in the “Add Filter ” dialog, the “Filter: rotate ” dialog will 

appear. (Pic3) 
4. According to your need to select the rotate degree. 

 
<Pic 2> 

 

 
<Pic 3> 

 

3.4 Compress Video 
Video Setting 

1. Please select “Video-> Compression”, and then the “Select video 
compression” dialog will appear (Pic4). 
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<Pic 4> 

2. In the list on “Select video compression” dialog, please select “Xvid 
MPEG-4 Codec”.  

3. After click Configure button. The “Xvid Configuration” dialog 
appears (pic5).  

4. In the Encoding type, there are three types in the selection. We 
suggest user select single pass or twopass. 

 
5. When select Twopass, it needs to compress the video two times; 

Two pass -1st pass and then Two pass 2nd pass. 
 
6. Set Profile @ Level to Highdef, and Encoding type: to Twopass – 

1st pass. 
 
7. Then please follow the next section to set audio and save the file. 
8. When 1st pass procedure has done, please do 2nd pass by setting 

the Encoding type to 2nd pass, then save to avi again. 
 

Pass Size  Compress time quality 

Single pass Small  Shot General 

Twopass big long good 
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Pic 5 
 

Audio Setting 
1. Please select “ Audio->Full procession mode” (Pic6) . 
2. Then select “ Audio -> Compression” (Pic7). 
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<Pic6>                        <Pic7> 

3. After that, the “Select audio compression” dialog will appear. 
4. We want use mp3 to our audio codec, so please select MPEG 

Layer-3 in the left list.  
5. In the right list, please select “128 kBit/s, 44,100Hz, Stereo 

16KB/s”. 
6. Then click “OK” to accept the setting and exit the configuration 

dialog 
. 

 
<Pic8> 
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3.5 Create Target File 
Finally, we are going to create the target file. 

1. Please select “File-> Save as AVI…”, and select the path where 
the destination file will be put. 

2. The Virtualdub will start to compress the video file according to 
above setting. 

3. You also could see the Status window when Virtualdub compress 
the video (Pic9, Pic10).. 

 
<Pic9> 

 
<Pic10> 

�


